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Legal Notice and Disclaimer
NOTICE

Nothing from this manual may be reproduced, transferred, copied or translated to any
language, in any form or by any means for any purpose. Trix Systems does not make any
guarantees, neither expressed nor suggested which includes all implied guarantees that the
program will work properly when operated in a careless way or if the system does not meet the
system demands. Trix Systems disclaims any responsibility of direct or indirect damage that
may be caused by loss of information, computer standstill or any other loss of data or any
damage that may be caused by the program.

LICENSES and TRADEMARKS

Trix Systems, Trix RasterServer, Trix ImageMaker, Trix Organizer, Trix FastDoc, Trix
DrawingCenter and TracTrix are trade marks of Trix Systems AB and Trix Systems, Inc. AutoCAD
is a registered trademark of Autodesk, Inc. Microsoft and Windows are registered trademarks
of Microsoft Corporation. Acrobat is a registered trade mark of Adobe Systems Corporation. All
other trade names referenced herein are either trademarks or registered trademarks of their
respective holders.

Trix Systems reserves the right to change and improve the product. All examples and symbols
used in the manual are made up and Trix Systems disclaims all responsibility for any
resemblance.

CAUTIONS

File formats are not standards. Variations of individual file formats exist and formats
continuously evolve. Any two files sharing a common file suffix or format may not contain
identically structured data. Where the software described in this manual is used to open,
display, print, create or otherwise manipulate or transfer files it is the user's sole responsibility
to inspect the results in order to assure accuracy and fitness for purpose. Trix Systems cannot
be held liable for any omissions, additions or changes in content. The existence of variations in
any format means that different software applications and computer systems, regardless of
vendor, may display or print the same file differently. We recommend that you establish and
employ procedures to assure yourself that the information contained in your files is presented
with the integrity and consistency necessary for your purposes.
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SECTION 1: INTRODUCTION

Why one document for two applications?

As TracTrix software builds on and extends the functionality of Trix DrawingCenter the two
applications share common instructions. The first three sections of this document are
applicable to both applications. The final Section 4 is only applicable to TracTrix users.

e Section 1 - Introduction: describes the software and licensing
e Section 2 - Functions: a table of reference for the controls provided in each tab

e Section 3 - Procedures: describes how to use the functions to perform common tasks in
both Trix DrawingCenter and TracTrix applications

e Section 4 - TracTrix specific Procedures: describes how to use the functions that are only
available in the TracTrix application

What does Trix DrawingCenter do?

The basic function of a viewer is to open files and display them. Trix DrawingCenter can do
much more than this. It is designed so you can access and use the information contained in
raster and vector engineering drawings in your everyday work.

With DrawingCenter you can print, measure, scale, markup and compare files. At the same time
it protects the original files from change. It is not editing software. If you mark up the drawing
the mark up information is saved in a separate file by the program (with a .TRX extension). The
original file is never changed.

What does TracTrix do?

TracTrix software adds the following additional features:

e Create and drop Symbols/Approval Stamps into drawings

e Save Redline, Symbols/Approval stamps into DWGs without needing CAD
e Vector to raster conversion

e Raster to vector conversion with Text Recognition

e Raster to raster conversion

e DWG Version conversion (save back to older)

e Raster editing

e Orthogonal adjust, de-skew, calibrate

e Despeckle/Fill holes in rasters

e Runs as ObjectARX inside AutoCAD



Installation and Licensing

Activate your license

Licensing is initiated with the serial number that you received in your product delivery email.
You must complete the activation process upon registering your license in the Trix Systems
License Manager. If activation fails, you should receive an error message. The application will
run in demo mode until the license is fully activated.

Installation instructions

Follow the instructions you received with your serial number. If you need help please contact
support@trixsystems.com. Keep copies of the instructions and installation files you received.

Moving the license to another computer

Use these instructions to deactivate the license on the original computer so it can be installed
on another computer. Before you shut down your original computer you must do the following.

e |f you do not have a record of your serial number, open the application and go to Help,
click About, then copy and save the serial number. You'll need it to reinstall the
program.

e Start the Trix Systems License Manager application. Select [[oeacthate eemse... | Complete the
on-screen deactivation. You will then receive an email notifying you that your license
has been successfully deactivated.

e On the new computer use the original installation instructions you received as though
you were making the installation for the first time to install and then reactivate the
license.

Image types

Trix DrawingCenter and TracTrix handle three different types of image files. It is important to
understand their differences because each type contains different information.

The first type is the raster image, produced when you scan a document or take a picture with a
digital camera or phone. It is usually a single layer of information stored in the computer file as
rows of ‘dots’.

The second type is the vector image. This can be a DWG, DXF or DWF file created in a CAD
application such as AutoCAD, a DGN created in Microstation or an HPGL file (usually with the
extension .plt) created by a traditional plotter driver in a CAD application. All vector formats are
mathematically based. Vector files can contain more information than raster files and are
usually much smaller files — they aren’t rows of dots. There may be multiple layers and views in
a single vector file. Vector files may use font descriptions stored elsewhere on your computer
as TrueType or AutoCAD SHX fonts. One vector file may ‘call’ other vector or raster files to
display as part of the overall image. These are called external references or X-ref files.

The third type is the Acrobat PDF image. These can be either raster or vector or a hybrid mix of
both.



The Trix applications enable you to simultaneously open raster, vector and PDF files. The tools
available at any one time will differ according to the type of file that is open and active.

First Use - Registering file types
Asocations .. ™99 The first time you launch your application the

;_o'““’ :::::’ kb dhlena S ST Associations dialog box appears allowing you to
03 OLshee o) L5 Cace register file extensions that you wish to open with
90 TFGops Descrpton our program. The list on the left shows file types
Eg E;:cémj; | already associated with the application. The drop-
S down menu shows standard file extensions to add.
E - Alternately, you can enter your own extension and

description. This dialogue is also accessible from the Settings tab under File types.

Note: Adding a file extension here doesn’t mean the application can open it. See Appendix 1 -
Supported formats

Program Settings

s’::"”w “ The settings for the application are accessible from the Settings

ke : oK == | tab under Program Settings.

v Default Unit

Ask for missing fort- or SHUH

e e = This sets the default units for measurements. You can also
manually change units when using the measuring tools.

When opening a file

Pen Widkh setby Pen Fie

1 Font files dreciory

|C:\Program Files\AutoCAD 2006\Foris\ | ShOW markup
i A When checked, the application displays markup by default when
s st e | it is opened. This is the equivalent of toggling the Show markup
1 Fast panting. (nay not be supported by all printers ico n.

Masicup files drectory |

Ask for missing X-ref in DWG/DXF
Check this box to be warned if required X-ref files cannot be found.
Ask for missing font or SHX files in DWG/DXF

The application looks for the TrueType and SHX fonts called by AutoCAD files in order to display
text as originally intended. Check this box if you wish to be prompted when a font cannot be
located.

See Page 23 for details about how the application looks for X-refs and SHX fonts.
Only show plot layers in DWG/DXF

This switches off display of layers set in AutoCAD as non-printing.

Show HPGL files black/white
The application displays color HPGL and PLT files as black and white.



DWG/DXF/DWF
Dark background

The application defaults to displaying vector files with a black background.
Black/White

Display all lines as black-on-white (or white-on-black if combined with Dark Background
checkbox).

Pen widths set by Pen File

Checking this box enables you to print colored vector lines with widths determined by line
color. See Page 26 for more information about how to use Pen Files.

Font files directory

AutoCAD SHX fonts are not stored in the Windows operating system. If you have drawings that
use SHX fonts and you wish to have them display correctly in the application you must point to
the directory that stores them. To do this, check the box, then click on the ... button to browse
to the directory where you have stored your SHX fonts. See Page 23 for details.

Hover

Mark objects automatically / Show object information

With these options enabled, information about markup entities is automatically displayed in
the form of a bubble.

Fast Printing

Leave this checked, unless you experience problems printing. Turning off Fast Printing may
resolve printing issues.

Markup directory

To store all .TRX markup files in a single directory so your markup is private to you, check the
box and navigate to the directory you created to store .TRX files. Typically this directory is set
up to be local to your computer.

Software updates

You can check for updates by clicking Search for updates, located under the Help menu.

Search for updates..

10



SECTION 2: REFERENCE

Using the Mouse

.
e Right-click/Hold & Drag for the Pan tool “'{?" to position the drawing in the window.
e Roll the mouse wheel to zoom in and out without using the Zoom tool.

e Scroll the mouse wheel over the menu Ribbon (or tabbed menus) to switch menus.

e Right-click to find hidden menus

Menu Shortcuts

New [Alt— F—= N]
Open [Alt— F— O]
Close [Alt— F- C]
Save As [Alt— F— A]
Acquire [Alt— F— Q-1]
Print [Alt— F- R — R]
Print Preview [Alt— F- R -V]
Print Setup [Alt— F— R =S]
Publish PDF [Alt— F— P]
Properties [Alt— F—- E]
Exit [Alt— F— X]

The Quick Access Toolbar
foc = TERORS L o) |

This toolbar is always available in the upper left corner. You can customize it to add the tools
you use most often. The tools shown by default are:

 Save markup (Crrl+s) Markup files have the file extension .TRX.

& Undo Undo the previous action (may be repeated for multiple undos).

Mouse click and drag to select the required area to view. Mouse wheels
can also be used for zooming in and out.

k"’
~ Zoom in

e Zoom all Removes zoom so that the entire image fits in the window.

Select Area. Use to select regions or items in a document for copying,
S Select (Alt+5) printing, and manipulating. Left-click and drag to select the required area.
To add additional areas to the selection hold down the Shift key and

11



continue to drag. Similarly you can use the Control key to subtract areas
from the selection.

R Select markup Click on markup objects to select them for editing, moving or deletion.

Customize the Quick Access Toolbar

Use the down arrow = and select Show Below the Ribbon if you prefer the bar to appear lower
down. Use  Mnimize the Ribbon to toggle the Ribbon (or tabbed menus) on and off. Choose
Mere Commands... | t0 select and add tools to the bar.

Tools in the File Menu

L i .

- > o Opens a file.

H B Ciles Save markup. For more information on saving markup, see Page 26.

B soverasteras... Use this for saving an existing raster file out to another raster format. The
raster formats available are in the Save As Type drop-down menu.

3 pubian or Make a PDF of the current document (with option to save to PDF or start
an email with the PDF attached). See Page 30.

é Acquire Scanning using TWAIN interfaces. See Page 21 for details.

g et Clsp Access Print menu-controls, including setup and preview.

_ oo Close the current document.

pEebe e Displays dimensions and other details about the file (see Page 22).

12



Start Tools Settings
e %7 ¥y MK NS K NNK QBRI IO &
Undo SeI:t E:c: Z::am :j Q !;‘ La%r Select A m S » Pyl ;D) v ‘Iifl ‘(| hl‘
B raste Area | Window Al B f 3 (8 A © £ | pdHorizont ovit P H I W @
Edit View Markup Raster 3D Dwg
& Undo the previous action (may be repeated for multiple undo).
Undo
b Cut For deleting markup and placing it in the clipboard.
=2 CopY yiic For copying selected markup to the clipboard.
) Paste Culsy For pasting markup from the clipboard onto the markup layer.
a Alt-5. Add another H H Ho
T aromwith SHIFT Use to select rectangular regions in a document for printing.
select Remove part of area
area  with Ctrl.
Start - View
oo in When you open a file the zoom tool is automatically selected. Click and

(t\ (or use scroll wheel)

Zoom
Window

drag to create the zoom. Note: this click and drag method is different
from the less precise single-click zoom used in other applications. The
zoomed-in region is delineated by a dashed rectangle.

.

Removes zoom so that entire image is displayed in the window.

Zoom
All
Gy Zoom out Click to zoom out to previous magnification.

(or use scroll wheel)

:j Adjust to width

Fit the image in the window’s width.

Q Lock Zoom

Newly opened drawings will be displayed at the current level of zoom.

@ Pan

Hold down left mouse button to pan inside window.

[1—] Filled objects

Turns display of fills on or off.

[g] Markup

Toggles display of markup and symbols on or off.

;' Drawing

Toggles display of CAD image on and off.

M2
Rotate tools

Rotates raster images in 90° increments CW or CCW.
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Start - Markup (Redline)

Markup is also described on Page 26.

N In order to Select an Object this tool must be active.

Select
A QR Markup drawn with these tools never changes the content of the
AR O R original file. Markup is saved into a separate file with extension
R A O % .TRX.

Markup
Start - Raster

Pl Invert the color values in the raster image (e.g. black becomes white).

= Rotate the raster image on either vertical or horizontal axis.

Pd

aster

Start — Raster Editing (TracTrix only)
B4, Pixel depth f"

I0] Change size =
Rasterize
Objects

Reduce or increase the bit depth of an image. B Pixel depth

Use to edit the sheet size and resolution of a raster image. Select a new

i . ) . . 10 :
size from the list or enter a new width and height to size the raster. & Change size

Crop the image. This is only enabled when a raster area has been

selected using the Select Area tool. Lol Crop
Add items with + SHIFT ("

Use to convert vector lines or markup onto the raster layer. Remove items with + =
Ctrl Rasterize

Chjects
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Start - 3D

This group is inactive for 2D files.

) = O 3 3D Orbit rotates 3D files for viewing from all perspectives.
~ QO H & O
20 :r ; I ® Right-click to pan the 3D image. 3D Orbit must be selected to
 3pDwg access the 3D tools shown below.

Display a wire frame image without

i=1)
surfaces.
() Remove hidden lines.
| Shade surfaces fully.
= Show the model in perspective.
W@l P  Top,side or end view.
Tools
Start Tools Settings
T w—sw AE Auto “3
1‘;.“%] % e gr—‘olyqon ﬁ Q
Set Check  Measure L DWG DWG
Scale Scale Length == Rectangle Size Font/X-ref

Tools - Dimension

Scaling procedures are described on Page 23.

11-@ Use this to set the scale of the drawing if you already know the scale.

Set
Scale

% (with optional f you do not know the scale of a drawing and there are dimensions
L-l’\

Snap) . . .
L shown in the drawing use this tool to calculate the scale.
ec
Scale
H— S(;V;t;‘)olo“ona' Once a scale has been set in a drawing you can take off a length by
clicking on two points in the drawing. Then right-click/Exit to display the

Measure
Length length.

A= Auto This tool automatically seeks out i
Add area with SHIFT boundaries, such as in a room, and b T e
Deduct area with Ctrl

measures area and perimeter. When the

area you wish to measure has been found, | =
right-click and Create an area object. If the —
tool misinterprets the desired area try starting from another point. To
retain the area as visible, hatched, markup, check the Save the area
object box.

Frrmeter Heght

Save the area chect

15



8 polygon Use this tool to take measurements of a non-rectangular region. Click
successively on nodes, and then close the polygon by right-clicking/Close.
Completed polygon shapes can be edited by selecting a node and
dragging. To retain the area as visible, hatched, markup, check the Save
the area object box.

BB pectangle Use this tool to define and take measurements of a rectangular region.
To retain the area as visible, hatched, markup, check the Save the area
object box.

Tools — Dimension (TracTrix only)

£ Height Use these tools to take off heights of buildings, measure angles such as
@ Check roof pitches and check accessibility space.
<y Angle

Tools - Utilities

™ &
DWG DWG
Size Font/-ref
AN Resize DWG, DXF or DWF files for printing by selecting a pre-set document
\ size (e.g. ANSI C), entering dimensions or changing the scale. Note: this
DS‘-‘-"G will not change the size of the image on screen.
ize
- Displays names of fonts and X-refs called by DWG or DXF files, and names
o of font substitutions made if any fonts are unavailable. If an X-ref is
Fogt""::,_ref missing the panel displays a message to this effect. Resize the panel to
- reveal long path names.
3 When two revisions of the same drawing T -
¢ are open, use Compare to display the .
Compare differences between the two. Select the

original and revised versions with the round

buttons and click on Compare. The

application will create a new drawing Pt g b sl o
showing deletions in red and additions in

blue. If the drawings are different sizes, use the Manual Adjustment to
align content before starting the comparator. Check the ‘Fix origin’ box if
two DWG files are to be compared in Model Space.
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Tools — Conversion (TracTrix only)

3 -.
b onhegoral g5 < =N N g

= Horizontal
Vectorizing _ Character  Despeckle Fill Deskew Callibrate
ol Vertical Recognition Holes

Conversion Tools

Launches the dialog box to begin vectorizing. (Raster images only).

=

Yectorizing

Use on vector/markup layer after vectorizing to ‘square-up’ vector line
corners and intersections.

k1 Orthogonal

Realigns (deskews) vector lines horizontally and vertically. 3 Horizontal
o Vertical
Launches the OCR program to convert raster text to ASCII text. (Raster A*
images only). "ﬁﬂ
Character
Recognition
Despeckle cleans images by removing small clumps of pixels that are not 3.7
required in the drawing. (Only available for 1-bit images) i
Despeckle
Fills in white pixels in black regions. (Only available for 1-bit images) m
Fill Holes
Rotates raster entities to deskew a crooked drawing. E !
Deskew
Calibrate adjusts the image size and scale on both x and y axes. |7i |
[=—=
Callibrate
Use to reduce the bit depth of the image to a limited range of spot colors. “
Color
Separation

Settings

=08
Mew  Tile  Tie Cascade
Windew Atross Down

Dv Program Settings are applied to the entire application. They are described on Page 9.

Program
Settings

17



j Use Pen Settings to set specific line weights for corresponding colors in a vector file.
Pen Instructions for how to use Pen Settings are detailed on Page 26.

Settings
- »b Used to manage file type associations (by file extension). See Page 9 for details on
*'F";e' registering and de-registering file extensions.

types
Settings - Show/Hide

/| File Browser Displays Explorer tab on the left to enable the File Browser and slide shows. See
Page 21.

/| Caption row Displays information about drawing above main window. The same information
is also displayed when cursor is rolled over the file name tab at the foot of the
main window.

V| statusRow  Displayed at the foot of the main window the Status Row provides access to
viewing and navigation tools, and key points of reference:

Hd4:2 -p» ¥ Navigate pages or layouts in multi-page documents.

<4 P Navigate between documents (if multiple documents are
open).

| In multi-page documents, this control toggles the activation of

5

the scroll wheel between page navigation mode and zoom
mode. In navigation mode, the scroll wheel tool can instead be

Use with scroll wheel

used to pan.
Magnifier Enables the Magnifier. The cursor will act as a hovering
Keyboard Toggle: Z magnifying glass. For details on using the Magnifier and other

viewing techniques, see Page 21. The Magnifier automatically
disables after one click.

/| Snap Check Snap to have your markup and measuring tools snap
Keyboard Shortcut: S (jump to) lines and nodes on the drawing.
Polyline Use Polylines to join vector-line end points to form a
Keyboard Shortcut: P continuous polyline. A key icon appears, enabling the points to

snap together.

2.272,8.076" Displays the cursor coordinates. 0,0 is top left.

Main Displays the name and color of the active markup layer.

Settings - Windows

= 10 = T
Hew Tile Tile Cascade
Window Across Down
il Opens a new window containing a copy of the current document. Use
,;’ this to zoom in to details in different regions of a drawing and view
yindow them side by side.
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i Displays open windows in vertical tiles.

Tile
Across

;% Displays all open windows in horizontal tiles.

Tile
Down

-

*: Cascades tiles in window.

Cascade

Objects (only visible when object selected)

“ Sttt  Tools Settings Objects
. Main - Fill 7] Transparent 200 il |

= User calor 7] Contour p—

Layer o - = 1phel - Entities

Objects - Layer

The Objects tab is visible whenever a markup object is selected.

Q Opens the Layer Control. Assign objects to a different layer and/or color
here. See Page 23.
Laver
Main v Use this drop-down menu to assign the selected object(s) to a specific
markup layer. See procedures for markup layers on Page 24.
7] User color Use to change the color of an entity from the default (which is set by the
Select color ~ Layer properties) to a user-selected color.

Objects - Appearance

@] Fill Use this box to select a fill color and pattern for entities with boundaries
B select color ~ (i.e. rectangles, polygons). When the Fill box is checked, Select color and
7 EAl parsrn s Fill Pattern become available.
/| Transparent Set transparency on markup entities.

] Contour The edges of filled entities are displayed as solids if the Contour box is
0.3 mm - checked. Use the sizing window below to set the width of the edge.
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Objects - Area

wa] 1T Sum areas. For use when you have multiple area-markup objects. Shift

orm  toselect - . : .
multiple entities  Select each area object in succession and then click on the Area icon to

display the total area for all the selected objects.

Area

Objects - New Entities

Ca o Record the characteristics of the selected

e = object and use these for all future markup,

Enkities either of the same type or for all new
objects.
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SECTION 3: FUNCTIONS AVAILABLE IN BOTH TRIX
DRAWINGCENTER AND TRACTRIX APPLICATIONS

If a topic has been covered in Section 2 it is not repeated here.

General Viewing, Navigation, and Printing

Opening files
Roll-over the orange Explorer tab and select the Push Pin # to dock the 2al~ [
T Explorer window. Access directories in the top frame and individual files in 3 A2.cal 777
z . . BLUML. .
i the bottom frame. Double-click on a directory to open/close. Use the drop-  ~ conol-cu
down box to filter for file type. '
st To reposition the Explorer, right-click the lower panel for a menu. Float the window
| off to make more workspace available.
W) > 3 You can ‘slide show’ files that are in a single directory. Use the Start

button ¥ to start a slide show. Each image in the folder will
successively display for 3 seconds. Duration can be changed with the drop-down menu. Use the

Stop button ‘! to end the show. Reduce memory use by using Close Previous '&d|. Otherwise all
the files will stay open in the application.

Scanning

Scan directly into the application from a scanner with a TWAIN interface using File — Acquire.
You can then markup and save the scan as a raster file.

Before you can scan you must establish a connection to your scanner by choosing D
Select Source. If your scanner has a TWAIN interface, you will see its name listed.
Select it.

Select source

Your choices are then to use the scanner manufacturer’s interface or the application’s interface
to make the scan.

Moving between pages and layouts

- Arrows at the foot of the main window enable you to move between pages and

layouts.
Zooming

When you open a file, the Zoom Window tool is automatically activated. Click and drag to
define the zoom area. Click Zoom All to display the entire image in the window. An alternative
for zoom control is to roll the mouse wheel.

On-the-fly magnification can be done using the Magnifier toggle. Press the Z key to activate the
magnifier. A circular area around the cursor will act as a magnifying glass. Moving the mouse
moves the position of the glass.
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If you use the Magnifier in conjunction with a measuring tool and you click the mouse, the click
point is registered, and the magnification disappears. This assists with precise measurement.

Displaying Shortcut Reminders

View the keyboard shortcuts by pressing the Alt button. The text [y T - —r
or digits corresponding to keys appear over the controls. After you llZl 1 1
use a shortcut (or Alt) the shortcut cues will disappear.

Snapping

Snap is used to automatically snap (jump) to lines and nodes on the underlying image.
E This means you do not have to spend time postioning the cursor precisely over a desired
point. Instead, as you move close to the point, the cursor will automatically find it and snap to
it. Snap activation can be toggled on the keyboard by pressing the S key or by clicking the
checkbox in the Status Row at the base of the window. Enable/disable the Status Row via the
checkbox in the Settings tab.

The size of the aperture (the little red square) can be peie ——
adjusted. Right-click, then click Properties to access the panel. ] eme

Increase the aperture to widen the snap area and decrease it
to tighten the snap area. Snap works best when the drawing is
zoomed out.

0K Cred | Help

File Properties

(37 Properies k=) Select Properties in the File menu to display information
BT i rmomesmssemee || about the selected file.
T toasomd a6

) Mumber of lagess: 1

B Size
= ) WG peopestes
1D Fie size: 184025 bytes
) Fie hype: AutoCAD RIZALTSS
- B Sie
10 Wi in diswing units 50018
6 Hewgh in diawing unts 23477
1) Insertion pont: 0.000,0.000"
0 wids 1388
O Heighe 9247

Raster file functions

Capturing raster clips (to paste into Word, etc.)

Use Select Area to define an area to copy. Then right-click the selection and select Copy. An
image of the area is now on the computer’s clipboard. Use this to paste detail into reports or
presentations.

Erasing regions

Since the original file cannot be changed the approach is to white-out the area to be hidden by
marking it up with a white rectangle. You can then cover this with new detail or text markup. To
do this, select the Rectangle tool. Create the rectangle and change the fill color to white.
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Saving raster files

Depending on the format of the original raster image opened you may be able to save it other
raster formats using Save raster as, accessible from the File menu. The raster formats available
are listed in the Save As Type drop-down menu.

Vector file functions

X-refs and SHX fonts

X-refs and SHX fonts are fully supported. The program looks for Xref files in three ways:
e Using the absolute path specified in the source DWG file;

e |[f the path is not found, using the specified path applied relative to the directory now
containing the source DWG (for X-ref's with filenames like ...\...\X-ref.dwg);

e [f still not found, searching the directory containing the calling AutoCAD file.

In Program Settings you can enable a warning about missing X-refs and fonts when opening a
file.

To view the X-refs and fonts called-for in a file, select DWG Font/X-ref under the Tools tab.
Substitute fonts used are shown here if the original font is not available. If an X-ref is missing
the panel displays a message to this effect. The panel may be resized to view long path names.

SHX fonts are used only in AutoCAD files. These font files are not stored in the DWG file. A path
to your SHX font directory should be specified in the Program Settings. If you do not have a
required SHX font the application substitutes another font. TrueType fonts are also used in
AutoCAD files. The application will use whatever TrueType fonts are available in your operating
system and make substitutions for any that are missing.

DWG layers

DWG/DXF layers are defined in the original AutoCAD file. They cannot be altered in Layer

the application but you can use the check boxes in the Layer control panel to control E N
the visibility of each layer. There are also Show all and Hide all buttons. Mo ks

=
To save a selection of layers for repeated use click the Read in button. This will
create a file containing the selection with the file extension ‘LST’. This file may be given any
name you choose. To reuse a layer file click on the Edit button and select the file you require.

Scaling Functions

Why scale?

A drawing must be accurately scaled in order to obtain accurate measurements. The application
provides the functionality to measure lengths, perimeters, and areas in real world units (e.g.
millimeters, inches, square-yards). In order to measure accurately, you must scale.

Most raster-images need to be scaled because they do not contain scale data, and are assigned
a 1:1 ratio by default. Vector files, on the other hand, usually have some scale ratio information
built-into the file. To see it, go to the Modelspace tab and click Set Scale from the Tools tab.

Scales work only in drawings that represent a single plane, typically a front, side or top view.
Scaling will not operate in drawings presenting isometric (3D) perspectives.
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Calculating the scale of a raster image

Scale tools are under the Tools tab. There are two ways to scale your drawing:

e Use Set Scale, and then enter the decimal value of the drawing’s scale in the Document
scale panel that appears (assuming the drawing was scanned at 100% if it is a raster
image). A drawing showing a scale of [ /4" = 1’- 0” ] translates to a decimal scale of
[1:48]. A fraction/decimal conversion table is in Appendix 3 on Page 55.

e Use Check Scale to set the scale using a known distance between two points. Click once
on the starter point—a visible line appears and moves with your cursor (if needed, press
Z to activate the magnifier)—then click again at the end point. The document scale
dialogue box opens, enabling you to enter distances and specify the unit of
measurement. Then round the scale to the closest decimal (i.e. 1: 48.065 would be
correctly rounded to 1:48).

Scale need only be set once for each file. The application will store the scale (and markups
created for the image) in the .TRX file associated with the original file.

Cross-checking a scale

You can also cross-check your scale with the Measure Length tool under the Tools tab.
Measure off a known distance. If the measurement shown in the window matches the line
dimension on a drawing, then your scale setting is correct.

Note: The scale may change within a drawing—different parts of a drawing can contain detail
drawn at different scales. Check to see that the scale you have set is appropriate to the detail
you are measuring.

Markup (Redline)

Markup layers

When a file is first opened a single empty markup layer is
created, named ‘Main’. Access the Layer control switch in
the Start tab (or if Markup is currently selected, in

the Objects tab).

Additional layers can be added using Create New. Set the
color of the layer using Edit.

Create different markup layers for each user or team. The checkboxes are used to set layers to
be visible.

While many markup layers can be seen at the same {_ =Y Y
. . Tix '
time, only one markup layer can ever be active at a < St Tods  Setigs | Objects
time—the active layer being the one currently in use n " | 4 R Trarepeceot
- User color = ¥ Contour

for markups. Use the radio buttons to select the Laver : N

active markup layer. The active layer is also indicated

in the status row at the bottom right of the main window where you see an ‘L’—the status bar
(page 19) must be turned on for this to be visible.
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Layer management is accessible under the Objects tab. This is active only after markup is
selected. You can assign markup layers to selected objects here.

Markup tools

The markup tools are available by clicking on their respective icons under the Start tab. With
the Hover option enabled in Program Settings, object information is automatically displayed in
the form of a bubble on rollover.

Setting the default color and pen width for markup

There are two choices for the default color used by the markup tool. You can either have the
color defined by the color of the markup layer in which you are working, or choose a color
irrespective of layer. Go to the Objects tab and click on User Color. Select the color to use.

Editing Markup Objects

Use the Select tool to select the markup to edit (use with Shift to choose multiple objects or
Ctrl+A to Select All). To resize an entity click on a control point (a square box on a corner of a
markup element) and drag with the mouse. Right-click on the markup to access a menu of
editing tools. Edit options will vary depending upon the type of object selected (text, rectangle,
line, clipart, etc.).

e (@ Rotate: Qutlines the markup and transforms the cursor into a crank. Drag the mouse to
turn the crank and rotate the markup.

o @ Movesde Epgpled only for polylines, this tool allows you to grab and skew a segment of
a polyline, leaving some points intact.

o Imertcomer | Adds an additional control point to a line. Click on the point where the
insertion is to be made. Right-click/Insert corner. See Page 22 for a description of how
these tools work.

e % @ Cutsthe markup and places a copy on the clipboard.

e =3 cwv Copies markup or the selected area to the clipboard. All or part of the image can
be copied to the computer’s clipboard for pasting into other images in the application or
into external applications, such as Microsoft Word or PowerPoint.

e 3Pt pastes markup from the clipboard. If pasting into Trix DrawingCenter or TracTrix
the drawing into which you paste must be active. To activate an image, click inside it
using the arrow cursor. Not all applications accept pasting and some may accept pasting
of raster clips but not markup.

o Dekte Deletes the selected markup.

° Properties...| Eor markup shapes this displays the aperture for the Snap feature and a
switch to Create polylines; for markup text this enables editing of the text; for raster
clips this displays properties of raster entity/region.

Sharing markup

If your colleagues also have Trix DrawingCenter/TracTrix and you are on the same network
using files on a file share you can see one another’s markup when you open the file.
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For users without Trix software you can share files, complete with rmarkup, by publishing the
file as a raster PDF using the Publish to PDF option in the File menu. Choose Send as e-mail to
automatically open a new email message with the PDF of your file, complete with any visible
markup, already attached, or save the PDF file locally. The size of the PDF you create, as well as
the dpi and other attributes, can be adjusted in PDF Settings.

Saving markup and .TRX files

Markup and settings created in the application is saved into a separate file. This file is
automatically given a name identical to the original with the addition of a new file extension
.TRX. For many users the only noticeable effect of this is the appearance of what appears to be
a duplicate file in the directory containing the image files. If the original file extension has been
associated with the application, clicking on either file will open the file.

If a drawing’s file name is changed you must also change the name of the related .TRX markup
file. For example, if file <original name.tif> is changed to <new name.tif> you must also change
<original name.tif.trx> to be <new name.tif.trx>.

To save markup as you work click on the = save Markup icon on the Quick Access Toolbar.

By default the application saves .TRX files to the same directory in which the original image file
is stored. This is the most logical place to store the markup data when working collaboratively
with other users of the application as this enables them to see the same markup when they
open the file from the same directory.

Alternately, you can designate a separate directory for the storage of the .TRX files. This setting
is applied to single workstation installations of the application. It enables you to maintain
individualized mark up for the images!.

Use Program Settings, accessible from the Settings tab, to specify a path to the directory where
you wish to store your .TRX files. Click the ... button to browse to and identify the directory.

Printing
CAD files

Use DWG Size under the Tools tab to specify a unit of measure and select a document size.
Changing the document size automatically adjusts the height, width, and scale in the fields
below. Manual entry of the desired width, height, or scale is allowed—the application
automatically adjusts the document size to fit.

Pen Settings

The line work in DWG, DXF and HPGL files is typically in a variety of colors, making it easy to
distinguish between design elements when viewing it on screen. Any given CAD or HPGL file can
contain up to 255 different colors.

! Advanced sharing and collaborating using markup is supported in Trix FastDoc and Trix Organizer document
management software, available separately from Trix Systems.

26



If you print to a monochrome (black and white) output device or printer the color distinctions
are lost. To recreate the distinctions in the form of varying line widths (or line weights) the
application uses Pen files. Access the control panel for this using Pen Settings under

the Settings tab.

The Pen width window displays the current pen widths. By default all s
colors are assigned the same pen width (0.18 mm). The application
always uses millimeters as the unit of measure for pen widths. To
alter the Pen Settings click once on the line item to highlight it, and
then click Edit.

i

| Line with

Click Save to store a set of pen widths for future use. This creates a
file with the extension .PEN which contains the values of the widths
as you defined them—the first line contains a width for color 1, the
second for color 2 and so on. Pen files are simple text files that can be opened and edited in
Notepad.

To re-use a previously created pen file select Read in. Multiple pen files can be created and
saved.

Hiding markup

Use the Vectors and Markup on/off toggle R to display or hide markup before printing. The

Drawing icon (i can be used in a similar fashion to print out only markup. (These controls also
apply when creating a PDF.)

Printing a partial detail

To print a sub-portion of a drawing use the Select Area tool. Click and drag to select the region
to be printed. Use Ctrl+P or File—Print—Print and choose Selected Area in the print control
box.

Printing Choices

The File — Print menu provides the options to

— Pt i Print all \ Preview
"IQJ Print cument document djj Print all opened documents j.’. Preview the print of the cument document
Print Print all. Preview

There is also the option to change Printer Settings, such as orientation (Portrait vs. Landscape)
or paper size/source.
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Drawing Specific Controls -

Options in the Print control box are:

Printing Pages = ot

If the file is a multi-page document, this round :
button gives you the choice of printing just the e
current page or all the pages in the document.

Watermarking )
Watermark ﬁ

Checking the Watermark box includes the currently Tet. 0T FOR USE AFTER “OATEC)

selected watermark in the print. Clicking on Properties M:”W: o - =
brings up the Watermark control panel where you can “m =
select the Watermark and create new ones.

Arial

Paper head

By using the appropriate check boxes, you can include s
the scale, date and time, file name or a user text string

at the head of the print. You can also position the

heading on the page using the Position settings.

Saie

Select area for printing

Use the round button to select the entire image, the extent of the image as seen in the main
window, or a selected area (see Printing a partial detail, page 33, for how to select an area).

Pen selection

Use the Black and White or Color round button to set use of color in the print. In DWG, DXF
and HPGL files, the width of lines can be set according to their original color values using a pen
file (for information on how this is created see Page 26). To use a pen file, check the Use pen
widths box and click on Pen Widths to select the pen file to be used.

Print Scale

To use as much of the printable area as possible, select Fit to paper. To use a scale whichisina
fixed proportion to the original scale of the image, check the In relation to the original
document box. Then enter the ratio that you want to use to scale the image. (For example, to
quadruple the size, enter 4:1. To halve the size enter 1:2.) When the ratio is entered, the
number of printed pages that will be produced is indicated below the scale. By default, a small
margin is added around the edge of each image. To switch this off check the No margins box.

HPGL and raster files are opened ‘actual size’--this means that if you print them at a scale of
1:1, they will print just as they were originally intended. DWG/DXF/DWF files are much more
complex as they may not contain any size information. DWG, DXF and DWF files are described
as ‘unitless’. Nevertheless the application attempts to best establish a size for you. You can
view and change the sheet size in the main program window using Tools—DWG Size.
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Printing using Paper Views

The Paper View tab in the left hand margin expands to show pre-stored frames that can
be used to create and print framed drawings when there is no existing frame in the
drawing or detail being viewed. The frame may contain a title block. Essentially these are

local layouts.

walA Jaded |4

If the frame contains text elements these fields are used to add textual information
describing the drawing. When a frame is added the user is prompted to enter text to

populate these fields.

The frames appear as thumbnails in a column to the left when the Paper View tab is clicked.

For example: you have a drawing containing a e
detail and no frame. You want to make a PDF of =2
this but it needs the type of information added
that would normally be found in a title block.

Drag a preformed frame from the Paper View
panel onto the drawing. You will be prompted to
enter text to fill the information fields.

Lapoust wttriute L]

-

The frame appears in the drawing with the portion
of the drawing that will be included shown in -
translucent grey. ]

15 38 van # |
i — l.‘.- L LLE)
5 o ibhes
|

Drag the frame to position it to cover the required -
area.

Now create a PDF (or print) as usual. The resulting
output made will then appear with a frame and
text.

The frame can be manipulated and deleted like a
markup object.
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Creating a PDF
PDF Settings

“ Start Tools Settings
] Hew Create a PDF of the cument document
& Open...
- Save 2sfie
H_ Save cuments document and redines, 25 a PDF file
B save as...

Save asfile.
i Close

Recent document

EEER o

Send as
Acguire emad

Send as e-mal
Send cuments document and redines, as & mal

Print

3 Properties.. D/
X Ext .

POF settings

POF settings
Settings for PDF export

Before using the Save as file or Send as email
functions under File — Publish PDF you should
create the settings that govern the creation of the
PDF file.

When you first select File — Publish PDF — PDF
Settings uncheck the Auto check box.

PDF Settings [
[ ] Auto: A4, dpi >=300. color, all pages 0K ‘
Document size

Cancel
ANSI C (22 x 17in.)
|
Dpi Margin |
300 - V|Color [VAipagess | 10 mm I
__

Choose Document Size and DPI (dots-per-inch, the resolution of the file). To prevent reverse
engineering of intellectual property, the application produces archival quality PDF/A PDFs.
These are raster images so the higher the resolution the greater the detail that can be

captured.

The All pages check box controls whether the PDF contains all the pages from the drawing or

just the displayed image.

Controlling what is in the PDF

Before creating your PDF use the toggle buttons from
the View menu to display or hide Markup, Fills, Raster

content and CAD content.

If you previously selected the Watermark check box in
the print dialog the Watermark will be included in any

PDFs created.

To limit the extent of the drawing use the Select Area
tool and check the Only selected area box in the Save as

dialog.
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Advanced Functions

DDE Commands

Dynamic Data Exchange (DDE) provides a way for Windows programs to share data and interact
with one another within your Windows operating system. Using DDE commands, Windows
exchanges information by requesting data from one application and instructing another
application to do things. Here is a list of the DDE commands available and an explanation of
usage for each:

#Open(File name[;File2;File3;...]) Opens one or many files in the application.
#Close([File name]) With no filename all files will be closed.
#Exit() Exit the application.
#Print(Filename;Scale;Printer;Paperhead;Scaleinfo;Showname;Time;Textinfo;Text)
Filename File to print
Scale 0=Fit(default), 100=1:100
Printer "Printer name"
Paperhead 0=No, 1=Yes
Scaleinfo 0=No, 1=Yes
Showname 0=No, 1=Yes
Time 0=No, 1=Yes
Textinfo 0=No, 1=Yes
Text "User text"
Examples of how it could look in the Explorer:

Open: #Open(%1)
Print: #Open(%1)#Print(%1)#Close(%1)

// Default printer and fit to page and no paperhead info
Printto: #Open(%1)#Print(%1;1;%2)#Close(%1)

// Selected printer, 1:1 no paperhead info
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SECTION 4 — TRACTRIX SPECIFIC FUNCTIONALITY

Symbol/Approval Stamps

Using the Symbol Library

_3 TracTrix is supplied with a basic library of symbols that may be
_--_' inserted into drawings. To access the symbols click on the tab in
'S the left hand border. This opens the current folder of symbols.
Select the symbol you wish to insert and drag it into position on
your drawing. Once the symbol is in position it can be resized by
selecting and stretching. Use a right mouse click to rotate.

3
o

‘Q\\‘.-
[I:] :m

e — =L
figiigiigiigii=1 = X

. — |

Symbols displayed in TracTrix are stored in a separate Symbols Layer. You can use the Layer
panel display of symbols on an off. EMF files are used to store symbolsin 4. smbos

regular folders. To access a different folder select the folder icon at the g
top of symbol panel and navigate to the required folder. The supplied set il
of symbols can be found in the Symbols folder in the TracTrix application Warning
folder.

Creating your own symbols and stamps

You can create a symbol by copying an area from an existing CAD file displayed in the viewer or
markup created using TracTrix and pasting this into the symbol library.

In this example the TracTrix markup Tools have been used to
create a Knock Out cloud.

To make the Knock Out cloud into a reusable symbol use the
Select Area tool to draw a boundary around the cloud.
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Right mouse click and select Copy.

The clipboard icon above the Symbol panel is activated.
a X
r @

~

Fill in a name for the new symbol.

The new symbol appears in the Symbol panel. A -
C:\Program Files (x86)\Tra...\Information ¥ | %

@“

Keep passage clear Knock Out Cloud

Saving Markup and Symbols into DWGs

Markup and symbols that have been inserted into DWG files using TracTrix can be saved into
Model Space in the DWG so that they are visible and available when the file is opened in CAD.
To do this use ‘File — Save As’ and choose a DWG format. You will be prompted to allow markup
and symbols to be stored in the newly created DWG.

NOTE: Symbols created from raster images (scans) will not display when saved into CAD files.
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Taking off Heights and Angles

¥ Height The Height and Angle tools place the measurements as regular markup on the
@ Check drawing. This can be stored and manipulated in the same way as other markup
£ Angle objects.

Heights and Pitches

The Height tool is positioned over a wall with the blue

upper and lower lines top and bottom. The height is

displayed in the H= box. The upper blue arm can then be =z

rotated to take off the angle of a roof pitch. This is i A=23°

displayed in the A= box. i e ; ‘

Both boxes can be selected and moved. H=4.697 mm

Angles

The Angle tool provides a digital protractor.
Drag it into position and manipulate the

arms to encompass the required angle. The
measurement is shown in the adjacent box.

h=134°

You can move the measurement box by
selecting and dragging.

Check

This tool creates a circle with a specified diameter. This is
typically used to check for adequate space for
handicapped access. Select the tool, enter the scale and
the required diameter and the circle will appear.

The circle can be moved around to check whether
apertures and areas have sufficient room.
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Orthogonal adjust, de-skew, calibrate

Orthogonal adjustment

k. Orthogonal | yse Orthogonal to straighten lines in the horizontal/vertical plane or baseline.

A dialog box is displayed in which the deviation angle and adjustment distance can be adjusted.

Maximum deviation sets the degree for which Orthogonal adjustment
those lines lying within the set value will be
orthogonally adjusted.

Max deviation:
003

. . . . . Max. adpustment i)

Maximum distance gives the maximum distance a

line segment can be lengthened or shortened to

achieve the adjustment. A
If Baseline is unchecked, the horizontal plane is X Ine 1l Ihe nil
used as baseline. ,—ﬁj ’—[_H

Use with Select | R [to identify a group of vectors to
be adjusted—other vectors will remain untouched.

[#]0ndy selected entities [] Baseine

Horizontal and vertical adjustment

ol Vertical | 3 Horizontal

Use these buttons to align all vectors to be on the same horizontal or vertical axis as an entity

you select—all vectors will be simultaneously rotated so that they maintain the same spatial

relationship with the selected vector. If you select a point on a Bezier curve TracTrix will use a

tangent to that point in determining the proper horizontal or vertical axis.

This action adjusts all vectors in a file. To adjust specific vectors, select them with Select k |,

and check Only selected entities in the action dialogue box.

Raster Editing

)_(-.
Use to select regions of, or items in, a document for copying, printing, i?jljcatriél\tvi_ﬂ?L SHIFT W
manipulating or deleting. Left-click and drag to select the required area. Deduct area with + Ctrl
Right-click/ES" Froperties... D.raws a freehand line of Freehand pen 3
. . e pixels.

to adjust line weight in pixels.
Images must be 8-bit or less (see Page Draws a straight line. Line pen _‘21
40).

Works well with Snap. Deletes pixels. Raster eraser =
Invert the color values in the raster image (e.g. black becomes white). Bl Invert

By Yertical
Pd Horizonkal

Rotate the raster image on a vertical or horizontal axis.
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Despeckle/Fill holes in rasters

Despeckle
Delete speckles

'Dirt" in the form of clumps of pixels can be automatically
removed using the Despeckle tool. From left to right, the S " =
slider adjusts from removing small pixel clumps of 0.10mm,
to removing larger clumps of 2.00mm.

Despeckle

a Fill

= For faded, broken, thin, or broken lines and gaps, use Fill.

Fill Holes ) . o )
The slider adjusts for filling pixel gaps from 0.10mm up to e Lo ]
2.00mm. Speci | Lo ]

Cycle Despeckle and Fill to enhance thin lines

When a raster image contains lines less than three pixels wide a cycle of Despeckle and Fill can
fill the holes and enhance the line edges. To obtain the best possible results when you start
with this less-than-ideal original, try Despeckling an image to remove dirt, then Fill to add back
'body' to faint lines or lines with white holes. Sometimes it works better to Fill first, and then
Despeckle.

Raster to Vector Conversion

Introduction

Raster to vector conversion is used to create vector lines from the lines on a raster image and
vector text from the characters on the raster image. The results are saved out to a CAD file
format.

CAUTION: The results from raster to vector conversion are rudimentary compared to drawing
in a CAD application itself. The functionality is most useful when applied to simple drawings
that are very clear.

The raster-to-vector conversion process includes five steps:
e Raster editing and clean-up to define boundaries for TracTrix to trace.
e Converting the text (otherwise they convert to unnecessary vectors).
e \ectorizing the image, adjusting settings and re-tracing as necessary.
e \Vector editing and clean up.
e Saving the vectors in a CAD file format.

The required steps are scanning, vectorizing and exporting—raster-editing is required if your
image is more than 8-bit—the others steps are optional.

1 For the conversion to 2D or 3D CAD of detailed, large or degraded drawings, Trix Systems offers a manual
conversion service at www.formatconversion.com. This service produces CAD perfect results.
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PDF files must first be converted to raster files before any raster editing and vectorizing can be
done. Each step is described in greater detail in this section.

A comprehensive tutorial is provided as a separate document and we recommend you read this
before attempting vectorization.

What images work best for vectorizing?

TracTrix creates vectors in or along the boundaries of two spot colors (or grays). A spot color is
an area of color where every pixel has the exact same color. True spot colors have no gradation
between colors. Take a look at the following images:

The grays in this image move gradually from very light on the left to very dark
on the right. It is impossible to say where to put a boundary line because there
are no boundaries. There are no spot grays in this image. Like a photograph, it
is entirely tonal. Contrast this with the image below where there is a clear
boundary between the two spot shades of gray.

In this image it is easy to see where to draw a line down the boundary, or line
of demarcation. And, just like our eyes, TracTrix prefers a well-defined
boundary in order to know where to create the vector line.

Quick start
Use Example Files: Logo.tif Plani.tif
£3 [cri+0) .
™ oruse the Open the TracTrix 6/Examples folder (usually in the Program Files folder). Select...
S Explorer File Browser
1 Logo.tif Plani.tif
o] Notice the dirt on the drawing. This image is clean.
Despeckle Fil Holes Clean the image with Despeckle
3 B Invert E'b Fixel depth in TOO'S tab_
& P vertieel 1 Ghangesi= | Accept defaults and click OK.
& | P Horizontal L} Crop Notice how dirt is automatically
cleaned.
Select Vectorizing on the Tools tab. From there, drop-down the setting menu and
choose...
Outline Architecture
I 5 Notice the green progress bar at the foot of the window.
Wectorizing
TracTrix creates blue vectors TracTrix creates blue vectors along the
around the black logo. centerline of the plan.
Ctrl+S to save it as a .TRX file.
8 Clicking the Drawing tool will temporarily hide the raster underneath the vectors.

Click it again to bring back the raster.

Notice how many of the lines are crooked.
Use Orthogonal to straighten lines
and square-up corners automatically.

The logo does not require orthogonal

b orthogonal .
adjustment.
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- l m— Save the vectors using Save As and choose Ctrl+S to save the .TRX file.
fiv T [Curl+ 5]
‘ (DWG, DXF, IGES, HPGL, etc).

Use Select Area % to export a specified area; switch on [¥]0nly selected areal in the export
dialogue.

Functions

Scanning a drawing into TracTrix
Pre-scan checklist

It’s assumed that you are scanning to vectorize the raster image in TracTrix.

e Prepare the original document to be as clean and sharp as possible.

¢ Avoid scanning from a glossy paper—it creates noise, uneven lines, and/or mirroring effects
on the scan; instead use a copy machine to generate a print on a flat-finished paper.

e Make sure that the original is placed in the upper right corner of the scanner, or in the
corner marked by 0,0 and that it is straight. Ensuring that the image is scanned straight
eliminates the need to deskew it later—one less task.

AdVvice for vectorizing photographs

Photographs create images full of subtly blending tones. The processing power of the human
brain enables us to render objects in photographs as discrete objects, but, as previously
described, vectorizing software works best with distinct breaks between colors. If you want to
convert a photograph into CAD vectors we recommend that you split the task between what
the human brain does best and what TracTrix does best.

Take a piece of tracing paper. Place it over the photograph. Take a solid black pen and trace the
lines you want to have represented in CAD, then scan the tracing paper into TracTrix as a 1-bit
image and convert the lines to vectors. Your brain will do a much better job of analyzing shades
and tones than any computer software will. TracTrix will convert your interpretations to the
vector format(s) you require.

Scanning settings

TracTrix enables you to scan directly into the program from a desktop scanner and save the
scan in a variety of raster formats, including TIFF, CALS, JEDMICS, C4, and more. Within TracTrix,
you can choose to proceed using the built-in software or your own scanning software. Establish

a connection to your scanner by choosing ﬁ_{s- T sawe Select Source. If your scanner has a
TWAIN interface, you will see its name listed; select it (most desktop scanners are supported).
Use —» aaure to access the scanning software, where you can adjust scanning settings.

Use the scan Preview repeatedly until you achieve the best possible quality.

Do not scan to PDF. This requires additional processing prior to conversion.

38



We suggest you start as follows:

Monochrome Images Gray Scale/Color Images
Examples: line art, drawings, schematics Examples: photos, blueprints, sepias
300 dpi 300 dpi
1-bit 8 bit
TIFF CCITT Group 4 TIFF with LZW compression

e Turn off dithering (or anti-aliasing). Dithered images look well on screen, but we want
defined boundaries along which TracTrix can create vectors. Dithering destroys these
boundaries. It may also be necessary to turn off any 'Color Enhancement' settings.

e Scan at 100% scale.

e If the lines on your drawing are light (pencil drawing), the reflectivity of the penciled lines
varies considerably and the scanner creates a raster image with black lines full of white gaps.
To compensate for this, adjust the Brightness.

Raster editing and clean-up

Techniques for selected areas

Everything visible in the raster image will convert to vectors. - |—|
You can choose either to vectorize an entire drawing or only a specific area. |
. - T8 10z [l
To vectorize a specific area use the Select Area tool |*%. -
)
A selected area can be adjusted to accommodate your needs. s
==
Use hot keys to add to, deduct from, or invert a selected area. .
Add area to selection + SHIFT L
Deduct area from selection = Ctrl I£

Invert selection Ctrl +1

Selected areas can be deleted, edited, or vectorized, leaving the areas outside of the selection
untouched. Right-clicking on a selected area provides access to standard editing functions,
including cut, copy, paste, and delete.

% cit  Shit+Delete Fill.. enables you to fill the selected area with a chosen
43 Copy crec | color. 1-bit images can only be filled with black or white. To add a solid
& Paste crl+v | colored shape to a 1-bit or grayscale raster image, use the Vector and
Delete Delete Markup tools.
Zzect P You can resize the moving red-dashed boundary to a specific paper size
—— with the Select format... button. This reveals a menu of standard
paper sizes—the selection resizes to the sheet size you select. This makes

it easy for printing an area of a big drawing to a small letter size sheet.
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Erasing content

To erase large areas of the raster image (such as unwanted text areas) use Select Area, then
press the Delete key. Use the Raster eraser &7 for relatively small areas and detailed line
editing. Right-click/ &' Properties... | to increase or decrease eraser size.

Bit-depth

When you open your image file in TracTrix, hover the mouse over the filename tab at the
bottom to see the file settings (or use fiv | Properties... ).

File Properties displays file name, type, path, and size on disk, as well as the dpi, bit depth, and
dimensions.

TracTrix can vectorize images up to 8-bit—anything higher requires down-sampling. TracTrix
has a Color Separation tool to do this. When a grayscale or color image is scanned in as 1-bit to
8-bit in the beginning, the scanner does the down-sampling for you. If your image is color or
grayscale, consider rescanning if you have access to the original document.

Avoid using JPG images—they are too imprecise for vectorization because their lines are
deliberately blurred with grey tones to give our eyes

SmOOther edges- Change Color depth
Current color depth: Desired color depth
Automatically reduce bit depth sl 2be e ¥ o
Colors: 660,520.31 Colors: 660,520.31

Use ®& Pixeldepth | to automatically and quickly reduce
bit depth. For more control over reducing the color
depth, use Color Separation instead.

Manually reduce bit depth

Color Separation categorizes every single pixel | "= ; F
Eﬁ color into groups (adjusted with the slider on =
sgggjg;im top) and displays them as a histogram. Each ‘
color group is separated by a vertical line i I'ITITIM '[::”w
called a delimiter. The height of each colored bar ,

represents the relative quantity of pixels of that color.

Here, you can edit the hues within each group, categorizing the
colors in a way that makes sense to the human eye.

The bar at the top of each group indicates the spot color that will be
used to replace the original colors in the group. Change the group
color by clicking on the color you wish to edit to open the color
palette.

To edit a bar location, drag it to a target group and release—in effect graphing the distribution
of colors.

With Show Colors checked, TracTrix will find the
corresponding color bar in the histogram and indicate its
location by flashing a solid bar around it.

Alternately, to locate the areas in an image that match the
color of a color bar, position the cursor over a color bar.
TracTrix will find and display the corresponding colored pixels in the original image.
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To split a group, right-click/Insert delimiter on the bar where you want the split.
To combine groups, move the delimiters.

The Preview switch immediately updates the image to reflect your edits.
Edit lines and edges for optimal vectorization

Fixing imperfections on the pixel paths

In the example on the right there are two problems:

e thereis agap in the lower line of the original raster, and

e two lines 'touch' near where they meet the vertical line. -

If left untouched, vectors will be created to perfectly reflect the imperfections in the original
raster.

Use the Raster Pen, Line, and Eraser to perform raster edits. In this

image, the pixel clumps between the lines were erased and the

broken line was repaired. This task produces a better quality raster
image to trace, which in turn produces higher-quality vectors.

The Raster Pen, Line and Eraser

2 The Pen and Eraser tools draw and erase freehand. Properties

y . . . Penwidhinpeeet [ 2| 0.0600inch
~ The Line tool draws straight lines. -
a2 selectedcolor [l [Setect coloe |

Use these tools to fill smooth edges. —
8 C= =)

Right-click/ &' properties... | to change the tool width or color
for the Pen or Line tools. Use the Objects tab.

Use the raster tools with Snap (Page 22) to enhance faint lines, smooth edges, and fill pixels.
Snap is best used when zoomed out.

Character Recognition

Text conversion options

Text should be converted before vectorizing linework; otherwise all your text will be converted

to vectors. It can be done manually with the Text tool o or, if the quality of the raster text is
good enough, semi-automatically with the OCR tool.

Examples of both good-quality and poor-quality text are shown below. Notice how the
characters in the poor-quality text touch each other, versus the well-spaced characters in the
good-quality text. Then notice how the text would convert using TracTrix’ default text library.

Good-quality text Poor-quality text

Original raster text. COU P |_| N G COLP LI\G

OCR conversion with
TracTrix default text library. COU P I—I N G C’)r)r)
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The text converted from the poor-quality raster is virtually useless—converting the text
manually using the Text tool would be best in this instance (see next section).

An alternate technique is to use Select Area x'k' to select good quality text to convert with the
automatic OCR/Character Recognition, and manually enter the rest. Vectorizing the text is also
an option. This is what it might look like based on the example above:

C O U P LI N G CO\JPLN G Vectorized with an

Outline setting.

C OU - Ll N 5 DOUPL N G Vectorized with a

Centerline setting.

Step-by-step instructions for Character Recognition are contained in the tutorial on Page Error!
Bookmark not defined..

Manual text conversion

Use this instead of the character recognition Point Size Height (inches) Height (mm)
capability for images in which there is only a 8 0.07 19
small amount of text. Zoom the text you wish 10 0.09 24
N __ to replace. Position the cursor at 12 0.11 28
d the top of the tallest letter. 4 0.13 33
Note the Y coordinates in the 16 0.15 338
status bar when the cursor is 18 0.17 42
both at the top of the raster text character 2 0-22 56
and at the bottom. Subtract to determine the 3 0.33 85
72 0.44 16.9

appropriate text height.

Select the Text tool @ —the cursor changes to a cross hair with an 'A' beside it. Click the upper
left corner of the first character to launch the text editor. After entering text and clicking OK,
proper ASCII text is placed on the vector layer of the image. Delete the underlying raster text so
it doesn’t convert to vectors when you vectorize. Right-click/ &' properties... | to change the text
font and size.

Using built-in OCR feature

P Character Recognition has a default database of raster characters and their ASCII
ch:;%l equivalent. It will work with the demo images provided with TracTrix, but it should be
Recogniton replaced with a text recognition database of your own making before you use OCR for

your drawings. This is done by “training” to interpret new characters. Click on

Character Recognition to launch the OCR function box.

Start
e Current font—displays the currently selected font. Dot &
Change this to resemble the text on your drawing. £
e Font—click to change. 2 (e
&=
42 Testbosght 0175 | [JLock  Cumert fort | Asl [ ru-uT
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o Text height—shows the text height of the currently selected text.
e Lock—sets the same text height for all new text.
e Only errors—only shows the text that TracTrix couldn’t identify.

e Change—change the found text to the text in
the text box. You may have typed in the text,

or it may appear based on the OCR Training. ‘JJ S -
Settings ﬁ S o
¢ Allow single characters—finds single 12 Fiom mf
characters. If not selected text found has to - 28
consist of at least two characters in order to
be recognized and converted. i b =
ok J[ conca J[ e ]

¢ Tolerance during text recognition—sets the
acceptance value for a character. Increasing the value requires the program to have a
higher confidence that it has correctly recognized a raster character before it will convert it.
Experiment with this adjustment to find what setting works best with your recognition
database and drawing portfolio.

o Tolerance for text heights—sets the highest and lowest character height to be accepted.
e Active network—the character recognition database that is currently in use.
Training
¢ Show database—shows which database will be used. Open a different database using the
OCR Settings.
¢ Create net—creates a new database.
e Save character—saves the classification of the character to the raw database.

o Number of ex.—shows how many example

Edit raw database L] characters are in the raw database.

Ascii | 51 Show database displays this window to view and edit
= 1 the characters in the raw database.

ﬂﬂ ﬂ ASCII shows the ASCII value of the character in the
window, while the Edit field shows the actual character

1ol
equivalent. Press the disk to save a new value for the
character.
Use the Texl recognition
W <] ] Arrows [ gy
to OCR .
browse the different raster images stored for the ::i
character, and the X to delete a character image =] g
from the database. R
It - Character: 7 of g2 Sefo*m-':r
Use the bottom arrows to browse the different i Sy =
text characters. Nrmberof ex. [0 Gese et
o J (o= )]

Once you have gone through each text area in the

?/ Erase the raster under the converted text?
-

43




document with the OCR tab, click OK to convert the raster text to vector text as identified.

TracTrix will ask if you want to delete the raster text underneath. It is a good idea—otherwise

the text will convert to vector lines in addition to the true text.

Vectorizing
Trace
The quality of the vector TracTrix creates is _ % N
tlv affected by th ter file attribut q Adjust trace Examine
greatly affected by the raster file attributes an settings i

the settings with which they were traced.
Accurate trace settings combined with a good-
quality, well-scanned image do a near perfect job.

'\ Delete Vectors IZ
(Ctrl + A>Delete)

Start vectorization

To begin vectorization, choose Vectorizing in the Tools tab.

Vectm‘z}ng Clicking Adjust provides access to the Trace Settings where they can be edited,
added to, and saved.

X The chart below shows the different pre-

Start vectorization

Seltings:
Aschitecture v| [Adust properties, for reference.
£ frneFr : —
c1!3.ellmgs: ] )
1
il < TracTriny v g 2 o Es <
g . oo = = an © g = =
RIS Y:  : & S-S PO .
Ml Architecture g5 ©cls 2 z5 g £ 2E
p| Cadastral , » = It B Bl == &=
Contour <TracTrix> C L 100 1.2 0.70
Exploded view i :
Logotype Architecture C L 1.2 0.40
Mechanical Cadastral ¢ L 10 0.8 0.20
Outline I i
Pump Contour c | B Yes 100 1.2 0.50
Exploded View c | B 1.2 0.40
Logotype O | B 100 - 0.20
Mechanical C L 1.2 0.60
Outline o} B 100 - 0.20
Pump C L 100 1.2 0.60
x...

\ If a specific area has been selected with the Select Area tool, only this area will be

select vectorized—the areas outside of the selection remain untouched.
Area
If no area has been selected the entire drawing will be vectorized.
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Trace settings

Trace method

The Centerline method traces the center of raster lines in the
image; the Outline method traces the solid edge of an image.

Maximum line width sets a tolerance for thick lines. Lines
thicker than the width dimension shown on the slider will be
vectorized on the outline.

Drawing entities
Choose which is best for your needs.
Tolerance

Precision sets how far the vectors can deviate from the
original raster line (higher value settings tend to reduce
number of vectors created).

Noise sets the diameter of the clump of pixels to be
vectorized. Smaller clumps will be ignored. With a Noise
setting of 0, TracTrix will process every single pixel, reducing
the likelihood of ‘steps’.

Max Arc radius—sets largest arc you will allow on the

Trace settings

Bt

Settings

Adpstments

&

Layer saparation

X]
Selitrg Trace mathod
O Dutine
(&) Centerine
Man. Ine thickness
a.0ar

schaechue| v
Save
Delete

Restoes lacicey
setlings

Diwing enbies

(®) Lines. arcs and circles
O Polyines

) Besiers and ires

o o [

Hep |

Ji

Settings

W

Adustments

Layer separation

Tolsance 00z
Precisson 3
0,008

House:

bk T
M Avc-radius

Intersactions
oors

Angle meassement

Angle divergence:

0.0075"
Intersaction distance:

o J[Ccomcel [ _Hep ]

J

drawing. By setting this value to 0, infinitely large arcs can be created.

Intersections

Angle measurement is used to adjust the direction coefficient for the lines in an intersection.
Drawings with small details (e.g. exploded views having radii under 2-3 mm) may be improved
by reducing this value. The disadvantage is that long straight lines could become hard to
connect in the intersection. This can be compensated for by increasing the angle divergence

(next setting).

Angle divergence is used to adjust the angle at the intersection

lines that do not intersect.
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between two close lines that will make the lines connect. Lines within
the divergence are connected but lines outside the divergence are
not. Too large an angle divergence could give the unwanted effect of

Original

AL

Thinned line




Intersection distance gives the maximum distance between 2 intersections that will still allow
them to be drawn together to one point. This is necessary to be able to connect the lines at the
intersection

Layering separation

|®| When f"‘ 1-bit cc?lor dep'Fh raster B T T T T
image is vectorized, a single vector Sebtings :vemm Upto  Line..
P o Layes 1 0.0000" Q0000
Layer separation |ayer is created and all the vectors 74 O Loyer2 007> oo | [_Deee
Adjustments QL‘W&B 0ons" 0027
are placed on that layer. & O Loyt Q078 003"
When a color image is vectorized, a new layer is e Constion

created for each vector color. Vectors can be
moved from one layer to another. New layers can
be defined prior to vectorization. Once defined
you can make a layer active and select raster =
areas to vectorize onto the active layer.

) (oo J [t

TracTrix enables you to place vectors on different layers based on the widths of the original
raster lines with “Separate lines according to line width”. The Layer name, Up to, and Line
weight are saved together with the current trace setting. A new layer is sorted on the value
given for Up to. The layer is not created until New is clicked.

Trace the lines and examine the results

Click Start when you are ready to trace. You will see a green progress bar at the bottom left of
the screen; vectors will appear when tracing is finished, blue for monochrome drawings,
colored on colored drawings.

Look at the vector quality close-up to see what adjustments can be made to improve them. To
show only the outline and hide the fill, click Filled objects %/ or hide the raster layer
altogether.

Pay attention to the raster image too, as it may need additional editing. TracTrix clean-up tools
help to automatically tidy up the vector entities. See next section for details.

Trace Restart the cycle if necessary
L
Adjust trace Examine Ctrl + A, Delete
settings results

If you wish to adjust settings and re-trace, you must
delete all of the vector entities first, providing an
empty vector layer to work on.

Delete Vectors
N (Ctrl + A%Delete)IZ
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Saving the vectors in .TRX files

Fiw H TracTrix vectors, markup, and settings are saved to a file named the same as the
Save as DWG/DXF X

original file but adds the file extension .TRX. While you

Al displayed markup and vectors will be saved as drawing objects in CAD.

work, click on the Save icon on the Quick Access fiites o5t e oct ik oll e = o 1< nfecist otec
Should the raster object be saved as:
Toolbar. O & embedded OLE object,
(®)10r a5 an external rtfewtfr.td raster FJ:
Saving as a DWG/DXF Fiename: lanl_saveds_i¥ =
Dpi: Color:

400 v

To save a vector file, use ﬁ*} H saveds.. Once the file
has been saved you can open it or import it to your save ] [Lechok ] [ concel
CAD, NC, GIS or other program.

When saving vectors to a DWG or DXF file, TracTrix will embed the raster layer as an x-ref.

To exclude the raster image from the exported CAD file, turn off the raster layer first. Or, if you
want to save only some of the vectors, select them first with Select k and save Selection only.

Editing vector lines and objects

Right-clicking on a vector entity displays a menu of standard editing tools!.

These tools are available for editing all vector types:
e () Rotate Outlines the markup and transforms the cursor into a crank. Drag the
mouse to turn the crank and rotate the markup.

® Explon Breaks vector lines into smaller pieces where indicated.
o & Cu shift+Delete | Cuts the markup and places a copy on the clipboard.
o 3 Copy cu+C | Copies markup or selected area to the clipboard. All or part of the

image can be copied to the computer’s clipboard for pasting.

o (I Paste ct+v | Pastes markup clipped from TracTrix.
° Delete pelete | Deletes the selected markup.
o &' Properties... For markup shapes, displays the aperture for the Snap feature, and a

switch to Create polylines; for markup text, enables editing of the text; for raster clips it
displays properties of raster entity/region.

Standard editing functions
These tools are available for straight line, arc, and Bezier curve vectors:

. Insert corner Insert corner enables you to insert a corner (add a node) anywhere on
the line or entity. To remove a corner, select the node and press the Delete key. New
corners are always unlocked.

° Break

1 Options available in this menu will vary depending upon the type of entity selected (text, rectangle, line, Bezier, etc).
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° Line -> Arc Line -> Bezier

Provides a means to select and change a single vector line to either an arc or Bezier curve.

° Arc -> Line Arc -> Bezier

Provides a means to select and change a single vector arc to either a line or Bezier curve.

Bezier - > Line Bezier -> Arc
Provides a means to select and change a single Bezier curve to either an arc or vector line.

Circle -> Arc
Provides a means to select and change a single circle to an arc.

4 Move side Enabled only for polylines, this tool allows you to grab and skew a
segment of a polyline, leaving some points intact.

Join points to form polylines
J Snap v Polyline

R With both the Snap and Polyline options enabled in the Status Bar, you can snap two
select  points together to form or add to a polyline. The “key” cursor indicates that the two lines
will be connected upon releasing the click.

Disconnect lines

To disconnect (add a “break” in a line), select the point on the vector ol

line where you want the break, then right-click/Break. The line is Break |
broken into separate pieces at the break point specified, but the end -
points of the two separate lines remain coincident at the point where the break was created.

Control Bezier curves

You control the shape of a Bezier curve in three ways: /
o the location of the end points;
e the direction of the handle; t
e and the length of the handle. p

The creation and manipulation of Beziers is best understood by practice. 7
Experiment with them on a new, blank document. P RO L

Corners on Beziers can be locked to maintain the shape of the curve on

Break either side of the corner.

v | Locked corner .
To lock a corner on a Bezier, select the node and "””EK\

&  Cut Shift+Delete - \
43 Copy CtrieC Unlocked o :
@ pate @bV pight-click/.  Locked comer : =S,

Delete Delete
B Properties... The same action applies to unlock a Bezier corner. Locked

Locked corner nodes on Beziers appear as circles. On unlocked corners they are square.
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Object properties
Select vector entities

k Use Select arrow to select the markup that you wish to edit (use with Shift to choose
select  multiple entities, or Ctrl+A to select all markup). To resize an entity click on a control
point (a square box on a corner of a markup element) and drag with the mouse.

View object information

An object information bubble displays size and entity detail, like the one on i) Object information
the right, when the cursor hovers over a vector entity. This feature is St o Rty
enabled by default; it can be toggled in the Program Settings. Hegh: 1400

Perimeter: 69.08 mm
Area: 290.4Z mm?

Here you can edit and define layer assignments, colors, and other
properties. Colors can be set by vector/markup layer (active layer shows
with the L in the lower right-hand corner of the window) or by a color Settings | Objects

you assign. V! Fill V| Transparent

. . . . B select color ~ | v Cont
The Fill option is only available when a closed or completely bounded L o)
B Filpattern ~ | 0.3 mm

vector area has been selected. Various fill colors and patterns are Appearance
available and will transfer to any CAD package that supports fills. For
fills, transparency and frame weight can also be specified.

Set the default color and pen

/.. From the Settings tab you can set a default colors for all new entities:

= e by the color of the active Vector/Markup layer (evident
Mew  with the L at the lower right of the screen ), or

2oty
Entities e choose a color to regardless of layer.

Use the round buttons in the window that appears to select Color by layer or Custom.
If Custom is selected the Select color button is enabled. Unless otherwise configured, new
vectors are placed on the default layer titled ‘Main’; it is blue in color.

For more information about how TracTrix manages layers, see page 23.

49



Vector to Raster Conversion

Use this to create PDF or other raster format files from your CAD files. This is useful for
protecting your intellectual property, making archive copies and creating images for Web sites.

y Brint

Use Zriv udimm ) igiimieonsmm P ——— )
f- 'JJ or [ ] OiitePrintes () To Raster Area e
to access the Print panel. Lot @21 ) Bod 18 bkt e | oo oo —
TIFF, CCITT, Group 4, [mudt] s
Pages R
©Cunont = a0
. . . () Black and whie
Make adjustments in this panel for any [ Paper head @ Coe
settings you wish to change. e
M H ‘omhon {rmm from COdr Osm
Use to specify the sheet size, s fenm e ) B e et
dpi, and bit depth of the export file. Pen

selection options enable you to convert color vectors to different line widths for output to 1-bit
raster files (see Page 26 for details).

Raster to raster conversion

A raster image open in the application may be saved out to a
different raster format using File — Save as and selecting the _
new format. Some raster formats degrade the original image so | .« e
the new image should be inspected for usability.

When converting to C4 JEDMICS (listed as CALS C4) be aware |
that the JEDMICS specification calls for 200 dpi resolution
images. Set this when you save to C4.

Running as ObjectARX inside AutoCAD

To start TracTrix in AutoCAD, start your AutoCAD and run the command 'APPLOAD',

then load one of the following modules depending on your platform.

Module:

TTA6_7_32.arx

Platform:

AutoCAD 2007-2009, 32-bit.

TTA6_10_32.arx
TTA6_10_64.arx
TTA6_13_32.arx
TTA6_13_64.arx

AutoCAD 2010-2012, 32-bit.
AutoCAD 2010-2012, 64-bit.
AutoCAD 2013-2014, 32-bit.
AutoCAD 2013-2014, 64-bit.

DWG Version conversion (save back to older)

Open a DWG or DXF file and use File - Save as. Select the older DWG or DXF version from the

list of formats.

50



APPENDIX 1 - SUPPORTED FORMATS

Raster-file formats

Raster files of this type are supported (including g=Multipage files or <*=color if indicated as such):

AFP ¢ IBM Presentation PTOCA (AFP)* % Portable Pixelmap, Binary
ANI 5] % Windows Animated Cursor PSP % Paint Shop Pro
AVI < Windows AVI* ¢+ Paint Shop Pro, RLE
AWD Microsoft Fax % Photoshop (Adobe)
BMP < 0S/2 Bitmap, vl and v2 PTK % IBM Presentation PTOCA*
£l % Windows BMP Uncompressed RAS % Sun Raster
«» Windows BMP RLE RAW Raw BitField*
Cc2 CALS Type 2 «* Raw Packbits*
Cc4 C4 JEDMICS % Raw RLE4* & RLE8
CAL CALS Type 1 ** Raw uncompressed data
CIN <+ Kodak Cineon RTF * RTF Format*
CIT Intergraph CCITT G4 SCT ¢ Scitex continuous tone
CLP “* Microsoft Windows Clipboard SFF Structured Fax File Format
CUR FEl % Windows cursor SGI1 <+ Silicon Graphics Image
CUT <+ Dr. Halo ¢ Silicon Graphics Image - RLE
DCR ¢ Kodak PDC* SID % Mr. Sid*
DCS < Kodak PDS* SMP % Xionics
DJV < Djvu* Xionics CCITT Group 3 1D/2D
ECW <+ Enhanced Compressed Wavelet Xionics CCITT Group 4
EPS «» EPS (Encapsulated PostScript) TFX Tiff -FX CCITT Group 3 1D
EPS with Embedded TIFF file Tiff -FX CCITT Group 3 2D
FAX % FAX, raw, CCITT Group 3 1D Tiff -FX CCITT Group 4
FAX, CCITT Group 3 1D, no eol Tiff -FX JBIG black/white*
FAX, CCITT Group 3 2D < Tiff -FX JBIG color/gray*
FAX, CCITT Group 4 1D ¢ Tiff -FX JBIG color/gray 2
FPX 2 % FlashPix % Tiff -FX JPEG*
% FlashPix, JPEG TGA % Targa
£l % FlashPix, Uncompressed ¢ Targe RLE
GIF ** GIF (Compuserve) TIF <+ Exif TIFF, Uncompressed
ICA I0CA, CCITT Group 3, 1d, -MO «» Exif TIFF, Uncompressed, YCC
g 10CA, CCITT Group 3, 2d, -MO g % GeoTIFF
I0CA, CCITT Group 3, 1d Tiff - CCITT Group 3 1D and 2D
I0CA, CCITT Group 3, 2d Tiff, CCITT Group 4
I0CA, CCITT Group 4, 1d & Tiff, CCITT Huffman
IOCA, CCITT Group 4, 1d, -MO < Tiff, JBIG
&  10CA, IBM MMR (+MO/-MO) £l < Tiff, JPEG 2000
I0CA, uncompressed (+MO/-MO) «  Tiff, JPEG 4:2:2
1CO < Windows icon « Tiff, LZW compression
IFF EJ % Interchange File &l % Tiff, Uncompressed CMYK
% Interchange File, RLE* « Tiff, Uncompressed YCC
< Interchange File - uncompressed £ % Tiff, Uncompressed
IMG < GEM Image «» Tiff, Packbits CMYK/YCC
ITG Intergraph RLE «  Tiff, Packbits
JPG < Exif JPEG £ % Tiff, Uncompressed
< Exif JPEG 4:1:1 =) < Tiff, Wavelet CMP
< JPEG WBM % Wireless Bitmap file
< JPEG (4:1:1and 4:2:2) WFX Winfax, CCITT Group 3 2D
<+ JPEG CielLAB Winfax, CCITT Group 4
<+ JPEG CielAB (4:1:1 and 4:2:2) WPG % Word Perfect Graphics
KDC ¢ Kodak DC* XBM % XBitMap
LSD Laser Data* XPM % XPicMap
MAC ¢ Mac Paint XWD ¢ X Window Dump (v10-11)
MSP < Microsoft Paint
NIF g  CALSType3 * - :
) % Kodak PhotoCD” Read Only files of this type cannot be exported
PCT [ % MacPict
PCX ¢ ZSoft PCX
PDF [ < Adobe Acrobat
PGM <+ Portable Greymap ASCII
<+ Portable Greymap Binary
PNG <+ Portable Network Graphics
PPM <+ Portable Pixelmap, ASCII
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Vector-file formats

Standard vector formats

Vector files of this type are supported

e AutoCAD DXF and DWG
Versions 12, 13, 14, 2000 - 2014

e Autodesk DWF

e 3D DWEF, and DWG

e Microstation DGN V7 and V8

e HPGL, HPGL/2 and PLT files (Read important information below regarding PLT files.)
e Acrobat PDF

HPGL Plotter files

Typically these have .hpgl, .hpg, .gl, .hp2, .plt, or .pl2 extensions.

PLT and HPGL files are plot files normally created with the Hewlett Packard Graphics
Language—a printer-control language that The Hewlett-Packard Company developed in 1989 to
drive their new line of pen plotters (commonly found in engineering departments and typical
to the industry). The simplicity of HPGL commands made it a desirable language to all plotter
manufacturers, and HPGL went on to set the standard for pen plotters of the day.

Plotters print their output by moving a pen across the surface of a piece of paper. The quality of
the pen plotters was impressive with the crisp lines it produced, and the precise, mechanical
movement of the pens, but this made it draw very slowly. Ultimately the pen technology
restricted plotters to printing only line art (no raster art), and a slow pace at that, so they faded
out with the introduction of laser and ink-jet printers

These days you’d be hard pressed to find a plotter—they have been replaced with faster and
more adaptable wide-format ink-jet and laser-jet printers. HPGL/2 was developed to enable
printers to act as plotters; to read, print, and create HPGL/PLT files of their own. Third-party
HPGL/2 drivers were created, and while these variants are usually based on standard HPGL,
they also contain additional commands that do not conform to the original H-P specification.
Having said that, HPGL files that have been created with a plot driver which employs original HP
commands are fully supported.

Note: The application does not support Gerber plot files, even though these may use the same
file extensions.
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APPENDIX 2 - CREATING PAPER VIEW TEMPLATES

Paper View frames are .TRX files stored in the folder named Paper View in the Trix
DrawingCenter or TracTrix application folder.

Overview

Paper View .TRX files must contain two layers

e The Main layer contains the line work for the frames and descriptions for any text fields

in title blocks you create. You can create this using the markup tools.
e The Attribute layer contains

0 Asingle markup rectangle that defines the extents to which the original drawing

will display when the frame is printed

0 Text Markup fields which will be filled with the text you enter each time you use

the Paper View.

o —— N— = In this example of a Paper View .TRX opened in Trix
e T | DrawingCenter the Main layer objects are in blue
and the Attribute layer objects are in red.

You must create the Attribute layer yourself each
time you create a new Paper View .TRX file.

Layer
s Lay&rname
Markup layer : gz%e
Creating new frames
To start creating a new Paper View you will need to =T . e —
open a scanned or PDF drawing which is already - S Kkt —
dimensioned to the size you want for your new Paper

View.
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Begin by creating the new Attribute layer.

| Layer

Q Layer rarma Create rew
. 2 @ tion :
Markup layer ¥ Ol s rams £t
Edit layer =)
| aper Ambue o%
B oo Cace

Then use the markup tools to draw the
elements of the new Paper View. If you e :
are using an existing drawing you might : :
trace some of its frame using the

rectangle tool in conjunction with Snap

to capture the corners.

At this stage all your markup uses the
Main layer. Hide the DWG layers and
your draft Paper View might look like
the illustration on the left. The hatched
line represents the extents of the
drawing you want to capture.

TS L TR

Next change the extents rectangle and the text elements that e I :m o s
will be the prompts to the Attribute layer. Main ] B Teanspar
= Attribute m t » | Contour

Layer -
\ &

ain * 1 pixel

Shift-select the elements so you can change them
all at once. They will now appear in the color you
created for the Attribute layer.

Close out of the drawing and save the changed
markup information when prompted. This will
create a .TRX file named the same as the drawing
you opened in the first place. Rename the .TRX
file with the description for the Paper View and
then move it to the Paper View folder in the Trix
application folder.

When you reopen the application your new Paper View will be displayed under the Paper View
tab.
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APPENDIX 3 — IMPERIAL TO METRIC CONVERSION TABLE

Inches to Millimeters

To convert inches to mm, multiply inches by 25.4. To convert mm to inches, multiply mm by 0.03937.

Inches Inches Inches
FRACTION DECIMAL mm FRACTION DECIMAL mm FRACTION DECIMAL mm

0.0039 0.1000 . 0.5512 14.0000 . 1.8898 48.0000

0.0079 0.2000 9/16 0.5625 14.2875 . 1.9291 49.0000

0.0118 0.3000 . 0.5709 14.5000 . 1.9685 50.0000

1/64 0.0156 0.3969 37/64 0.5781 14.6844 2 2.0000 50.8000
0.0157 0.4000 . 0.5906 15.0000 . 2.0079 51.0000

0.0197 0.5000 19/32 0.5938 15.0813 . 2.0472 52.0000

0.0236 0.6000 39/64 0.6094 15.4781 . 2.0866 53.0000

0.0276 0.7000 . 0.6102 15.5000 . 2.1260 54.0000

1/32 0.0313 0.7938 5/8 0.6250 15.8750 . 2.1654 55.0000
0.0315 0.8000 . 0.6299 16.0000 . 2.2047 56.0000

0.0354 0.9000 41/64 0.6406 16.2719 . 2.2441 57.0000

0.0394 1.0000 . 0.6496 16.5000 21/4 2.2500 57.1500

0.0433 1.1000 21/32 0.6563 16.6688 . 2.2835 58.0000

3/64 0.0469 1.1906 . 0.6693 17.0000 . 2.3228 59.0000
0.0472 1.2000 43/64 0.6719 17.0656 . 2.3622 60.0000

0.0512 1.3000 11/16 0.6875 17.4625 . 24016 61.0000

0.0551 1.4000 . 0.6890 17.5000 . 2.4409 62.0000

0.0591 1.5000 45/64 0.7031 17.8594 . 2.4803 63.0000

116 0.0625 1.5875 . 0.7087 18.0000 21/2 2.5000 63.5000
0.0630 1.6000 23/32 0.7188 18.2563 . 2.5197 64.0000

0.0669 1.7000 . 0.7283 18.5000 . 2.5591 65.0000

0.0709 1.8000 47/64 0.7344 18.6531 . 2.5984 66.0000

0.0748 1.9000 . 0.7480 19.0000 . 2.6378 67.0000

5/64 0.0781 1.9844 3/4 0.7500 19.0500 . 2.6772 68.0000
0.0787 2.0000 49/64 0.7656 19.4469 . 2.7165 69.0000

0.0827 2.1000 . 0.7677 19.5000 23/4 2.7500 69.8500

0.0866 2.2000 25/32 0.7813 19.8438 . 2.7559 70.0000

0.0906 2.3000 . 0.7874 20.0000 . 2.7953 71.0000

3/32 0.0938 2.3813 51/64 0.7969 20.2406 . 2.8346 72.0000
0.0945 2.4000 . 0.8071 20.5000 . 2.8740 73.0000

0.0984 2.5000 13/16 0.8125 20.6375 . 2.9134 74.0000

7/64 0.1094 27781 . 0.8268 21.0000 . 2.9528 75.0000
0.1181 3.0000 53/64 0.8281 21.0344 . 2.9921 76.0000

1/8 0.1250 3.1750 27/32 0.8438 21.4313 3 3.0000 76.2000
0.1378 3.5000 . 0.8465 21.5000 . 3.0315 77.0000

9/64 0.1406 3.5719 55/64 0.8594 21.8281 . 3.0709 78.0000
5/32 0.1563 3.9688 . 0.8661 22.0000 . 3.1102 79.0000
0.1575 4.0000 7/8 0.8750 22.2250 . 3.1496 80.0000

11/64 0.1719 4.3656 . .8858 22.5000 . 3.1890 81.0000
0.1772 4.5000 57/64 .89063 22.6219 . 3.2283 82.0000

3/16 0.1875 4.7625 . .9055 23.0000 . 3.2677 83.0000
0.1969 5.0000 29/32 .90625 23.0188 . 3.3071 84.0000

13/64 0.2031 5.1594 59/64 .92188 23.4156 . 3.3465 85.0000
0.2165 5.5000 . .9252 23.5000 . 3.3858 86.0000
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Inches Inches Inches
FRACTION DECIMAL mm FRACTION DECIMAL mm FRACTION DECIMAL mm
7/32 0.2188 5.5563 15/16 .93750 23.8125 3.4252 87.0000
15/64 0.2344 5.9531 .9449 24.0000 3.4646 88.0000
0.2362 6.0000 61/64 .95313 24.2094 3172 3.5000 88.9000
1/4 0.2500 6.3500 .9646 24.5000 3.5039 89.0000
0.2559 6.5000 31/32 .96875 24.6063 3.5433 90.0000
17/64 0.2656 6.7469 .9843 25.0000 3.5827 91.0000
0.2756 7.0000 63/64 .98438 25.0031 3.6220 92.0000
9/32 0.2813 7.1438 1 1.000 25.40 3.6614 93.0000
0.2953 7.5000 1.0039 25.5000 3.7008 94.0000
19/64 0.2969 7.5406 1.0236 26.0000 3.7402 95.0000
5/16 0.3125 7.9375 1.0433 26.5000 3.7795 96.0000
0.3150 8.0000 1.0630 27.0000 3.8189 97.0000
21/64 0.3281 8.3344 1.0827 27.5000 3.8583 98.0000
0.3346 8.5000 1.1024 28.0000 3.8976 99.0000
11/32 0.3438 8.7313 1.1220 28.5000 3.9370 100.0000
0.3543 9.0000 1.1417 29.0000 4 4.0000 101.6000
23/64 0.3594 9.1281 1.1614 29.5000 4.3307 110.0000
0.3740 9.5000 1.1811 30.0000 41/2 4.5000 114.3000
3/8 0.3750 9.5250 1.2205 31.0000 4.7244 120.0000
25/64 0.3906 9.9219 11/4 1.2500 31.7500 5 5.0000 127.0000
0.3937 10.0000 1.2598 32.0000 5.1181 130.0000
13/32 0.4063 10.3188 1.2992 33.0000 5.5118 140.0000
0.4134 10.5000 1.3386 34.0000 5.9055 150.0000
27/64 0.4219 10.7156 1.3780 35.0000 6 6.0000 152.4000
0.4331 11.0000 1.4173 36.0000 6.2992 160.0000
7116 0.4375 11.1125 1.4567 37.0000 6.6929 170.0000
0.4528 11.5000 1.4961 38.0000 7.0866 180.0000
29/64 0.4531 11.5094 11/2 1.5000 38.1000 7.4803 190.0000
15/32 0.4688 11.9063 1.5354 39.0000 7.8740 200.0000
0.4724 12.0000 1.5748 40.0000 8 8.0000 203.2000
31/64 0.4844 12.3031 1.6142 41.0000 9.8425 250.0000
0.4921 12.5000 1.6535 42.0000 10 10.0000 254.0000
1/2 0.5000 12.7000 1.6929 43.0000 20 20.0000 508.0000
0.5118 13.0000 1.7323 44.0000 30 30.0000 762.0000
33/64 0.5156 13.0969 13/4 1.7500 44.4500 40 40.0000 1016.000
17/32 0.5313 13.4938 1.7717 45.0000 60 60.0000 1524.000
0.5315 13.5000 1.8110 46.0000 80 80.0000 2032.000
35/64 0.5469 13.8906 1.8504 47.0000 100 100.0000 2540.000
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INDEX

.trx files, 38, 39 Font, 16, 23
3D Orbit, 15 Frames, 30
Accessibility Gerber
checking, 35 not supported, 54
add Heights
area to selection, 40 taking off, 16, 35
angle Horizontal Adjust
max. deviation, 36 vectors, 36
orthogonal adjustment, 36 HPGL, 8, 54
Angles Image types, 8
taking off, 35 Installation, 8
Aperture, 22 Invert color, 14
Approval Stamps, 33 Keyboard shortcuts, 22
Area Layer
fills, display on/off, 13 in DWG/DXF, 23
AutoCAD, 8 markup, 24
versions supported, 54 navigating, 21
Boundary selection, 19
autofind, 15 Layout, navigating within files, 21
Calibrate image, 17 Licensing
Caption row, 18 activation, 8
Cascade, windows, 19 Magnifier, 18, 21
Centerline Markup, 24
trace setting, 45 display on/off, 13
Character Recognition, 42 editing, 25
Clipboard, 22 hiding for printing, 27
Color penwidth, 25
invert, 14 rotate, 25
printing, 28 save into DWG, 34
Separation, 17 sharing, 26
Command Line control. See DDE Commands tools, 25
Compare drawings, 16 transparency, 20
Contour, around markup, 20 Measure, 15
Coordinates, cursor, 18 Menu Shortcuts, 11
Copy, 13 Mouse actions, 11
Crop, 14 ObjectARX inside AutoCAD, 51
DDE Commands, 32 OCR, 17
Default characteristics database, 44
save, 20 Orthogonal adjustment, 17
Deskew Page
orthogonal adjustment, 36 advance, 18
raster, 17 navigating within files, 21
vectors, 17 Pan, 13
Despeckle, 17, 37 Paper head, 28
Directory Paper Views, 30
TRX files, 26 template creation, 55
DWEF, 8 Paste, 13
DWG, 8 PDF, 8
line width, 28 creating, 31
resize, 16 Pen Settings, 27
versions supported, 54 Photographs, vectorizing, 39
Xrefs, 23 PLT, 54
DWG Version Polygon, markup and measure, 16
save back, 51 Polylines, 18
DXF, 8 Powerpoint, paste detail into, 22
Email PDF from file, 26 PowerPoint, paste detail into, 25
Erasing, 22 Printing, 26
Explorer, 21 partial detail, 27
File Program Settings, 9
advance, 18 Quick Access Toolbar, 11
browser, 18 raster
properties, 22 snap, 42
Fill, 17, 20, 37 Raster, 8
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despeckle, 37
editing, 36
fill, 37
formats supported, 52
rotate, 13
specific functions, 22
toggle on/off, 13
Raster to Raster conversion, 23, 51
Raster to Vector Conversion, 37
Rectangle
markup and measure, 16
Registering file types, 9
Resize, 16
Roof
Measure Pitch, 16
Scale, 23
check, 15
Printing, 28
set, 15
Scan, 21
pre-scan checklist, 39
settings, 39
Select, 14
area, 13
Shortcuts, 22
SHX font, 23
Snap, 18, 22
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Spot color, 38
Sum areas, 20
Symbol Stamps, 33
Symbols
save into DWG, 34
Thin lines, enhance, 37
Tile, 19
Title block, 30
Truetype font, 23
TRX files, 26
Undo, 11, 13
Vector, 8
Drawing tools, 14
formats supported, 54
specific functions, 23
vertical adjustment, 36
Vector to Raster Conversion, 51
Version differences. See Compare
Watermarking, 28
Width, zoom to, 13
Window, new-duplicate, 19
Word
paste detail into, 22
Word, paste detail into, 25
Xref, 16, 23
Zoom, 13



